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Copyright 

The data in this document may not be altered or amended without special notification from ETAS 

GmbH. ETAS GmbH undertakes no further obligation in relation to this document. The software 

described in it can only be used if the customer is in possession of a general license agreement or 

single license. Using and copying is only allowed in concurrence with the specifications stipulated in 

the contract. 

 

Under no circumstances may any part of this document be copied, reproduced, transmitted, stored in 

a retrieval system, or translated into another language without the express written permission of ETAS 

GmbH.  

 

© Copyright 2024 ETAS GmbH, Stuttgart 

 

The names and designations used in this document are trademarks or brands belonging to the 

respective owners. 
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1. Introduction 

Dear customer, in this document you will find the latest information about MDA V8.6.7 Hotfix 1. 

1.1. Definitions and Abbreviations 

Abbreviation Definition 

EHI ETAS Help Desk International 

FNE FLEXnet Enterprise 

KIR Known Issue Report – For severe Problem Reports which occur after a release, 

ETAS has introduced the Known Issue Report to inform affected customer 

immediately. The current Known Issues of former versions can be found on the 

ETAS website: http://www.etas.com/kir 

LiMa License Manager  

MDA Measure Data Analyzer 

MDF Measure Data Format 

SP Service Pack 

 

1.2. Privacy Disclaimer 

Please note that personal data is processed when using MDA. As the controller, the purchaser under-

takes to ensure the legal conformity of these processing activities in accordance with Art. 4 No. 7 of 

the General Data Protection Regulation (GDPR/EU). As the manufacturer, ETAS GmbH is not liable 

for any mishandling of this data. 

Through the use of this product measurement data that may include person-related data can be pro-

cessed. This measurement data, for example, include vehicle identification numbers (VIN) or vehicle 

number plates as well as GPS, video, audio or other measuring data. The exact data recorded in each 

case is determined by you when you configure your measuring system. Note that, in such cases, you 

are responsible for the legally compliant handling of the data in accordance with applicable national 

law. 

Technical and organizational measures 

This product does not itself encrypt the person-related data respectively data categories that it 

records. Ensure that the data recorded are secured by means of suitable technical or organizational 

measures in your IT system, e.g. by using classic anti-theft and access protection on the measure-

ment hardware. Person-related data in log files can be deleted by tools in the operating system. 

1.2.1. Data Categories 

1. When using the ETAS License Manager in combination with user-based licenses, particularly the 

http://www.etas.services/kir
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following person-related data and/or data categories that can be traced back to a specific individual 

is recorded for the purposes of license management: 

- User data:  User ID 

- Communication Data: IP address 

2. When using the ZipAndSend functionality for reporting product defects to us the logfiles and user 

settings file included in the zip file may contain file paths on your system, e.g. the full file path to a 

measurement file used in MDA. If you use personal data in your file paths (e.g. the user id) and you 

do not want this data to be sent you will have to remove it manually from the logfiles (via text editor, 

e.g., notepad) and from the user settings file (via database editor, e.g., DB Browser). 

3. When using the GPS instrument, GPS data points are not sent to the external data provider but 

processed and visualized internally within the tool. Particularly the following person-related data 

and/or data categories which can be traced to a specific individual is used for the purpose of 

visualization: 

4. Measurement Data: GPS data points, particularly the following person-related data and/or data 

categories that can be traced to a specific individual is send to the external map data provider 

(Omniscale GmbH) and used there for the purpose of providing the requested map data and for 

detecting and preventing malicious attacks on their infrastructure: 

- Communication Data: IP address 

1.3. Conventions 

The following typographical conventions are used in this document: 

Choose File → Open Menu / Ribbon commands are shown in boldface. 

1.4. User Documentation 

For details about the installation, see Chapter 2.4 ‘Installation’ on page 9. 

The user documentation for MDA V8 can be found in the installation folder on the PC, namely here: 

%Program Files%\ETAS\MDA8.x\Documentation. . 

After installation documents are accessible from MDA V8’s Home Page or via the Help ribbon.  

It includes: 

- What’s New  

Functionality newly introduced with MDA V8.6.x is described in the “MDA-V8.6.x-Whats-New.pdf” 

document. The slide set is cumulative, i.e. it includes separate sections for all Service Pack 

releases of MDA V8.6. 

- Manuals and Videos  

Different documents are provided: MDA V8.6.x user documentation in PDF format,  

a brief overview of MDA V8 functionality (slides "MDA V8 Functionality Overview"), and several 

videos demonstrating MDA V8 functionalities. 

- Hot Keys 

A comprehensive list of supported keyboard short-cuts is provided. The list can be sorted per 

column, by clicking onto the column header. 



 

 

Page 7/23 

Release Notes | MDA V8.6.7/1 

2. Product Definition 

2.1. Functions at a Glance 

MDA V8.x represents the new generation of ETAS’ measure data analysis tool. It combines  

- High performance and user-friendly operation concepts 

- Support of different measure file formats, best performance can be achieved using MDF V4.x 

format version in combination with ASAM Standard indexing 

- Support to read and interpret CAN bus trace files (BLF format) in combination with a CAN bus 

description file (DBC or ARXML format) (add-on required)  

- Applying a time offset on measure file level, or for individual signals  

- Export of measure data and measure file format conversion, including customer-specific textual 

file formats, and equidistant re-sampling of time stamps 

- Several instruments to visualize recorded data  

(e.g., oscilloscope, scatter plot, table, battery imbalance table, battery imbalance graph, battery 

imbalance histogram, basic statistical data, event list, GPS map, video (add-on required) …) 

- Persistency of many settings selected by the user to reduce re-configuration efforts 

- Flexible definition of rule sets for truncating signal display names selectively 

- Support of calculations, namely by creation of so-called calculated signals, usage of predefined 

calculations, and usage of ASCMO models by means of FMUs 

- Interoperability with INCA V7.x (preferably V7.4.x):  

Opening of MDA with last recording from INCA Experiment, or during recording as  

so-called ‘snap-shot’ (MDF V4 only) 

- Interoperability with EHANDBOOK-NAVIGATOR (preferably version V11.2 should be used): 

Open interactive documentation from signal level in MDA, and synchronized cursors  

- Comfortable usage of configuration templates. i.e. using the same configuration in multiple 

instances with different measure files 

- Export of a configuration and all files assigned to it in one zipped file. 

- Import of  

o MDA V8 configurations whereby contents can be selected for import like assigned files, layers 

and instruments, calculations, or display name rule sets 

o INCA and MDA V7 configurations (*.xda files, and *.xcs file) 

- Additional command line tools for GUI independent measure file handling: 

o mdfconvert.exe for conversion of formats, extraction of signals or time range, and resampling 

with equidistant time stamps 

o mdfcombine.exe for merging or appending of MDF files  
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2.2. General Description 

2.2.1. System Prerequisites 

The following minimum system prerequisites have to be met: 

Required Hardware 2 GHz dual-core processor, 2 GB RAM 

Graphics card with a resolution of 1280 x 1024,  

1GB RAM, 32 bit color and DirectX 9 

Required Operating System WINDOWS® 8.1 (64 bit) 

WINDOWS® 10 (64 bit) Version 1803 or higher 

WINDOWS® 10 Enterprise (64 bit) LTSC 2016 or higher 

WINDOWS® 11  

WINDOWS® Server 2016 (64 bit) * 

WINDOWS® Server 2019 (64 bit) * 

WINDOWS® Server 2022 (64 bit) * 

Required Free Disk Space 5 GB (not including the size for user application data) 

 

The following system prerequisites are recommended: 

Recommended Hardware 3,0 GHz quad Core processor or equivalent, 16 GB RAM 

Graphics card with a resolution of 1280 x 1024,  

1GB RAM, 32 bit color and DirectX 9 

Recomm. Operating System WINDOWS® 10 (64 bit) Version 1803 or higher 

Recomm. Free Disk Space >10 GB 

*Note: See also section 2.5 ‘Licensing’ on page 10. 

2.2.2. Software Prerequisites 

Administrator Privileges  

To install the program, you need administrator privileges. 

User Privileges 

To work with the program, each user must have read and write access for the following folders and 

directories: 

- %ProgramData%\ETAS\ 

- %LocalAppData%\ETAS\ 

2.2.3. Restrictions 

Other or older versions of WINDOWS® operating system than mentioned in the System Prerequisites 

(see section 2.2.1 ‘System Prerequisites’ above) are not supported.  

Installation is only possible on a native 64 bit operating system. 
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2.3. Delivery 

MDA V8.6.7/1 is delivered with an installation routine, including MDA software, documentation, tools, 

utilities, and further information. All software documentation is available in the Portable Document 

Format (PDF), which requires Adobe® Reader®.  

In the main folder of the unzipped installation package “MDA_8.6.n_Released_xyz” the installation 

itself and the documentation are available. Do not change the folder structure! 

There the file “setup.exe” is provided to install or update the MDA related software. The file “MDA-

V8.6.n-Whats-New.pdf” describes new features implemented in the new MDA version. 

In the sub-folder “Readme” additionally the Release Notes, the Installation Guide, and documentation 

about Open Source Software can be found. 

2.3.1. Used 3rd Party Software 

The 3rd Party Software used by MDA V8.6.x is listed in the folder:  

\ReadMe \OpenSourceSoftware \ of the installer. 

After installation of MDA the document can be found in the folder:  

\Program Files \ETAS \MDA8.x \Documentation \OpenSourceSoftware \... 

2.3.2. Used Components 

Together with MDA V8.6.7/1 the following components are shipped and optionally installed: 

- DirectX V9 

- .Net-Runtime Environment 4.8 

- ETASSHARED (IPManager only) 14 

- ETAS License Manager (LiMa) V1.8.11 

- MCD Core V1.2 

- Visual C++ 2019 Redistributable(x64)  

ETAS software products are sharing one installation of ETAS License Manager (LiMa). Accordingly, 

each product installation installs the LiMa software only if there is an older or no version available on 

the target computer. Another ETAS software product might update LiMa to a succeeding version.  

2.4. Installation  

MDA V8.6.x can be installed independently or using INCA Service Pack Installer.  

Details for the installation are described in the document “MDA_InstallationGuide.pdf” which can be 

found in the \ReadMe \ folder of the installation package or can be downloaded from the ETAS 

Download Center. 

2.4.1. Installation Hints 

Installation of V8.6.771 Service Pack replaces any former Service Pack of MDA V8.6.x.  

Depending on the actually installed software and components a reboot might be required after 

installation but before MDA V8 can be started. 
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2.5. Licensing 

MDA V8.6 is protected by means of an electronic licensing. 

In order to run and use the product, a valid license file is required that needs to be installed via the 

ETAS License Manager. The license manager is opened during the installation and can also be 

started at a later point as an external program located in the ETAS program folder in the Start menu. 

Independent from the Operating System, and the kind of used electronic license,  

only one instance of MDA can run on one machine at a time. 

The license file can be obtained through a self-service portal on the ETAS website by using the 

software entitlement you received during the order process, or it is provided by your tool coordinator. 

For using MDA V8.6.x an existing MDA V7.2 license is accepted.  

A valid license for INCA V7.2, V7.3 or V7.4 includes usage of MDA V8.6.x. 

Since MDA V8.6.0 in case of a machine-based license only an FNE license is accepted. 

3. Changes  

This chapter describes changes with respect to the previous version of MDA V8. 

3.1. What’s New  

New functionality introduced with MDA V8.6.7/1 is documented in the “What’s New” slide set. The 

slide set is cumulative, i.e. it includes What’s New slides of all former MDA V8.6.x versions. It can be 

found in the installation folder on the PC, and is accessible in the application itself via the Home Page 

→ or Help → What’s New.  

3.2. Compatibility to Earlier Releases 

MDA V8.6.x supports to load and reuse configurations from any former (i.e. older) MDA version since 

V8.2.x or higher.  

Configurations saved with MDA V8.6.7/1 cannot be opened with a former MDA V8.x version. 

Since MDA V8.5.1 the location for storage of customer specific configuration files for ASCII format 

based measure files was changed to the following directory: 

%ProgramData%\ETAS\MDA\8.x\CorePlugins\ 

Etas.TargetAccess.Targets.MeasureFile.Formats.AsciiConfigurable 

New and existing configuration files for textual file formats (*.ini) should be stored in the new directory 

to enable usage in MDA V8.6.  
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3.3. Fixed Problems 

This section describes the set of fixed problems of the released version of MDA V8.6.7/1. 

 

3.3.1. MDA V8.6.7/1 

EHI Number Title 

747065 MDA8 mapping of variables fails after exchanging measure files 

The new version MDA V8.6.7/1 prevents a problem which was introduced with MDA V8.6.7. 

If the configuration was not opened and saved with MDA V8.6.7, you are not affected. 

With MDA V8.6.7 a signal might be displayed partly correctly and partly as signal in no-match state, 

although the signal was displayed properly in in former versions. If such a configuration was saved 

with MDA V8.6.7 a manual work-around in MDA V8.6.7/1 is required. Select one of the signal 

instances in no-match state, and perform a manual ‘Signal Replace’ with the option ‘Everywhere’. 

 

3.3.2. MDA V8.6.7 

EHI Number Title 

633846 MDA8: Setting color per data group. 

665780 Axis Scale with 1.4e7 not meaningful 

667380 Easy comparing a signal with the same signal in different files. 

697564 Bei der Anzeige von Messwerten in der Signalliste wird gerundet. 

714128 

MDA8 Feature Request: set color for all signals in a measurement file to compare 

easily multiple files 

715700 MDA Feature Request - Unique color for all variables from measured file 

716709 MDA863_Display_of_exponential_axis_values 

717330 

3 x Ex-ID: #592283044>>>System.InvalidOperationException: Die Sequenz enthält 

keine Elemente.>>> 

721477 MDA8 Mapping Dialog out of INCA XDA Import shows 2 Devices with same Origin 

723865 Device mapping does not work with MDA V8.6.4/1 

728256 MDA 8.6.5 shows unnecessary Mapping Dialog in Compare to MDA 8.6.4 

730878 MDA8 Missing Signals without Device name after mapping 

733608 

MDA8 left drag and drop popup comes with space between mouse and popup with 

>100% 
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736557 

MDA8: moving signals with same/common axis into a new stripe (ie. Ctrl+T or menu 

entry) in oscilloscope leads to single axis again 

736712 

MDA8: unexpected opening of all stripe axis configs after closing it before to better 

change the axis values of only one stripe 

737016 MDA8 shows no signals with reason Record ID is invalid 

737392 Operations with high numbers of signals 

737408 

1 x [Ex-ID: #1689389266] System.InvalidOperationException: Sequence contains no 

matching element 

737557 

MDA8: moving signals with same/common axis into a new stripe (ie. Ctrl+T or menu 

entry) in oscilloscope leads to single axis again 

738164 

1 x [Ex-ID: #3027547748] System.NullReferenceException: Der Objektverweis wurde 

nicht auf eine Objektinstanz festgelegt. 

738301 1 x MDA 8.6.5 report Ex-ID: #246284913 

739355 Device Mapping dialog should not appear 

739618 

2 x [Ex-ID: #3402113869] System.ArgumentException: An item with the same key has 

already been added. 

740241 MDA_ Device Mapping Dialogue pops up unplausible 

740641 2x Ex-ID: #2376902820>>>System.NotSupportedException: 

740770 [Requirement] MDA8: time unit [s] is displayed on Oscilloscope Screenshot 

741768 MDA accepts symbols in file names for mf4 files, but not for blf files 

745498 1 x MDA 8.6.4 report Ex-ID: #2540154044 

746121 1 x MDA 8.6.4 report Ex-ID: #3140366255 

746453 

2 x [Ex-ID: #2588512238] System.Runtime.InteropServices.COMException: 

UCEERR_RENDERTHREADFAILURE (Exception from HRESULT: 0x88980406) 

750503 

1 x [Ex-ID: #369935330] System.ArgumentOutOfRangeException: Der Index lag 

außerhalb des Bereichs. Er darf nicht negativ und kleiner als die Sammlung sein. 

752978 

1 x [Ex-ID: #600000770 System.ArgumentOutOfRangeException: Der Index lag 

außerhalb des Bereichs. Er darf nicht negativ und kleiner als die Sammlung sein.] 
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3.3.3. MDA V8.6.6 

EHI Number Title 

715763 Signals_in_.mat_measurefile_exported_from_MDA8_Cannot_be_read_into_Matlab 

722165 One configuration file (XDX) can not be opened twice 

722488 MDA does not paint sample connection 

722983 Calculate_maximum_of_multiple_input_values 

726781 

[NetWBID2539630620] System.InvalidOperationException: Die Sammlung wurde 

geändert. Der Enumerationsvorgang kann möglicherweise nicht ausgeführt werden. 

726837 MDA interaction with Total Commander regarding replacing measure files 

727671 Text is cut in Device Mapping Dialog 

728964 MDA 8 crash after remove file 

730825 MDA8 layers are imported from a to z and not in the given order 

730830 MDA8 Replace file shortcut is not working when closing a second configuration 

732307 

1 x Ex-ID: #1318187711 System.NullReferenceException: Der Objektverweis wurde 

nicht auf eine Objektinstanz festgelegt. 

 

3.3.4. MDA V8.6.5 

EHI Number Title 

697569 Min/Max-values are missed in MDA-view 

709978 1 x [Ex-ID: #4032109188] 

710707 2 x Ex-ID: #1624402131>>>System.ArgumentException: An item with the same key 

has already been added. 

714855 Export Measurefile: MDF4.1 to MDF4.1 -> 929 Signal Errors 

718376 MDA Window is not visible/not usable 

719590 Stripe position can sometimes not be changed 

719818 Oscilloscope: the table next to the visual representation is slightly misaligned 

720469 MDA8 after multiple replacements the osci display of measure date is not correct 

anymore, looks like load interruption and MDA8 will hang up while closing 

720485 Zip and Send: Pressing "Create Report" kills Outlook process if in draft mode 

720509 After changing position of a empty layer, no variables can be added to the layer 
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720744 Unsigned Float32 signal from Bus trace was wrong. 

723565 1 x [Ex-ID: #3271811827] Autofac.Core.DependencyResolutionException: An 

exception was thrown while activating Etas.Eee.McdClient.Instruments.Y 

724850 1x [Ex-ID: #2664045854] >>>System.ComponentModel.Win32Exception: Not enough 

quota is available to process this command 

726343 Signal values are shown with factor 10 

 

3.3.5. MDA V8.6.4/1 

EHI Number Title 

719387 MDF Export results in an empty file 

 

3.3.6. MDA V8.6.4 

EHI Number Title 

612475 Measure file replacement with different devices does not work properly 

654809 MDA shows a signal incorrect 

664340 MDA8 painting oscilloscopes wrong 

664983 MDA : signal display problem 

665241 MDA 8.5.x shows a wrong visualization from signal when 2 timestamp a far away 

677088 CPG Support: MDA allows multiple instances of same .xdx open simultaneously 

683169 Controller Mapping in MDA 

683537 MDA mapping does not work properly for several ECU at replaced files 

694730 Cursor Tooltip for event signal hides some information 

706798 MDA8: file extension will be overwritten after export of the measure file 

706835 MDA 8 cannot show data from .aff file when .dbc file contains some variables with 

wrong description 

708044 1 x [Ex-ID#4091652698] System.InvalidOperationException: Collection was modified; 

enumeration operation may not execute. 

710830 Customer is not able to replace the measure file ,The signals are grayed out and 

cannot be displayed in the oscilloscope 
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710989 MdfCombine.exe  leads to message "Error occurred: Invalid handle" 

712239 MDA shows several Raster groups 

712530 MDA does not show $ActiveCalibrationPage always correct 

712651 1 x [Ex-ID3392646975] System.Runtime.InteropServices.COMException: Klasse nicht 

registriert 

713340 1 x [Ex-ID3675168403] System.ArgumentException: At least one input value is not a 

double value 

714527 MDF Combine does not works on Porsches PC 

715792 Signal_description_in_MDA8_is_worse_than_in_INCA_if_desciption_is_long 

 

3.3.7. MDA V8.6.3 

EHI Number Title 

627601 Comments from measurement are not shown in Oscilloscope 

689316 MDA Time Offset GUI improvement per selected signals. 

699753 1x [Ex-ID: #1476393256] >>>System.InvalidOperationException: The window which 

should be moved was not found.>>>  Data: System.Object = null 

701304 1x [Ex-ID#1503223649] System.InvalidOperationException: Cannot call StartAt when 

content generation is in progress. 

701422 MDA crash with Dump on McdCore when loading the mdf4 file 

703027 Creating Calculated Signal with Time Offset 

705455 The comment is not completely shown 

705746 MDA replace file performance 

705747 Change a size of XDX between versions 

 

3.3.8. MDA V8.6.2/1 

EHI Number Title 

702183 MDA _Export Fails 
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3.3.9. MDA V8.6.2 

EHI Number Title 

622874 Attempt to sort bit signals leads to unintended result 

629581 moving bit signals in oscilloscope signal list with the mouse places the signal at the 

end of the list 

634364 Time Slider on Table 

674976 Calculating a low pass filter with a time constant 

678038 Signal order for boolean signals can not be sorted 

680741 Quick win MDA8ff: remember last window size of "Quick Switch" 

681243 Support Call: Bustrace MDA 8.5.6 

685544 ASCII file output raster question 

688716 no signals visible at all, but if the available signals are copied to a new oscilloscope 

they are visible 

688759 MDA_ escape of not allowed xml-string characters does not work _and so the 

comment is not displayed after export 

690631 1 x Ex-ID: #985527913>>>System.NotImplementedException: Die Methode oder der 

Vorgang ist nicht implementiert. 

691563 Cannot_read_mat_file_into_MDA 

692116 1 x [Ex-ID:#1120918856] Autofac.Core.DependencyResolutionException: 

693581 Context menu sporadically not correctly created 

694017 [MDA] AccessViolationException in ETAS::CalcEngine3 in MDA 8.6.1.501 and higher 

694164 MDA does not read the measure files from encrypted folder 

694564 inconsistent Hotkeys Oscilloscope and Scatter plot 

695503 Oscilloscope set an error while zoom in with a signal in hex view 

695530 If a signal is moved to a new axis still the old axis for the signal is active 

695531 [Ex-ID: #2588512238] MDA8_attaching external Monitor leads to MDA crash 

697372 XDX configuration from previous version cannot be used 

697618 Calculated Signal makes the whole Layer unreadable 
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3.3.10. MDA V8.6.1 

EHI Number Title 

601840 1 x [Ex-ID#2588512238] System.Runtime.InteropServices.COMException: 

UCEERR_RENDERTHREADFAILURE (Ausnahme von HRESULT: 0x88980406) 

615053 INS feature adds a new signal on first strip only 

615380 Ex-ID: #2588512238 - System.Runtime.InteropServices.COMException: Ausnahme 

von HRESULT: 0x88980406 

633844 Time aligning by difference in cursor positions. 

633850 Insert key behaviour change. 

654818 Not possible to combine measurement files which were created by MdfConvert 

661384 Intuitive time offset operation 

667277 1 x [Ex-ID: #991183747] System.Runtime.InteropServices.COMException: 

UCEERR_RENDERTHREADFAILURE (Ausnahme von HRESULT: 0x88980406) 

667279 Worse stability if MDA is in the background during working with other applications 

667334 MDA 8.5 crash with empty error message after long uptime/sleep cycles 

669158 WG: A: MDA 8.5.3 stürzt ab/friert ein beim abdocken (HDMI + LAN abstecken) 

673809 4x [Ex-ID: #2588512238]>>>System.Runtime.InteropServices.COMException: 

UCEERR_RENDERTHREADFAILURE (Ausnahme von HRESULT: 0x88980406 

675152 ‘Insert’_add_selected_signals_into_1st_strip_of_Osci._instead_highlighted_strip 

678795 Recording Big Data-named recorded WP and RP dataset in the recorded mf4 file with 

same name saved 

679084 Measure file reading buffer is in inconsistent state 

680219 1 x [Ex-ID #1567775142] System.InvalidOperationException: An attempt was made to 

transition a task to a final state when it had already completed. 

681036 1 x [Ex-ID#1985088516] Ice.ObjectNotExistException: Exception of type 

'Ice.ObjectNotExistException' was thrown. 

682483 Bus Trace signals are not visible 

682967 1 x Ex-ID: #901792681>>>System.ComponentModel.Win32Exception: Das System 

kann das angegebene Laufwerk nicht finden>>> 

684252 MDA shows wrong cursor value if cursor is near to the edge of the osci 

686747 1 x [Ex-ID#2245390755] Ice.ConnectionRefusedException 
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687883 1 x [Ex-ID#2329148363] System.NullReferenceException: Object reference not set to 

an instance of an object. 

688399 Copy and Paste a layer caused MDA-JP System doesn't work 

688556 MDA hangs by operations with VECTOR mf4 

 

3.3.11. MDA V8.6.0 

EHI Number Title 

648422 1 x [Ex-ID#1812071447] Autofac.Core.DependencyResolutionException:  

An exception was thrown while activating 

658145 Favorite Axis configuration 

659056 2 x [Ex-ID: #607010195] >>>Ice.ConnectionRefusedException:  

>>>  Data: System.Object = null 

664263 Issue in MCD Core with read data into MDA and Matlab 

665517 1 x [Ex-ID#1497665653] Ice.ConnectionRefusedException: 

666139 1 x Ex-ID: #1691235217>>>Autofac.Core.DependencyResolutionException / during 

opening a configuration 

666548 7 x Ex-ID: #2331439533>>>Ice.ConnectionRefusedException:  

>>>  Data: System.Object = null 

667156 1 x [Ex-ID#2771847360] Autofac.Core.DependencyResolutionException:  

An exception was thrown while activating Etas.Eee.McdClient.Instruments. 

YtOscilloscope.UI.AxesProperties.AxesTabBehavior. 

669221 2 x Ex-ID: #1316256484 Eine vorhandene Verbindung wurde vom Remotehost 

geschlossen 

672141 2 x [Ex-ID#3167807335] Autofac.Core.DependencyResolutionException:  

An exception was thrown while activating 

Etas.Eee.McdClient.Signals.UI.ViewModel.SignalMetadataViewModel. 

672581 1 x Ex-ID: #1203314273>>>Ice.ConnectionLostException:  

>>>  Data: System.Object = null>>> 

672777 Problem with display of signals in existing oscilloscopes from different measurement 

files 

673291 1 x [Ex-ID: #1018730722] Ice.ConnectionLostException:   

Data: System.Object = null 

673796 1 x MDA crash without EX-id 

https://etas-tfs.de.bosch.com/tfs/web/wi.aspx?pcguid=a19b416c-a152-41b1-be99-52dd18194b4b&id=658145
https://etas-tfs.de.bosch.com/tfs/web/wi.aspx?pcguid=a19b416c-a152-41b1-be99-52dd18194b4b&id=672777
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673863 2 x [Ex-ID: #3509404394] crash while load measurefile in existing Config 

674139 MDA 856 Build 749 with BusTrace AddOn shows implausible measured values 

674620 Osci -> Export Measure Data -> Export of all signals does not work. 

674665 Measure files recorded with INCA V7.3.5 cannot be used in MDA =>V8.5.6 

676741 1 x Ex-ID: #1813691989 after Standby and add Variable to Osci 

678471 Error message that another user is logged on or another instance of MDA is open 

takes over 5 minutes 

678570 Time unit should be converted during export only for master time 

679861 MDA8_Copy screen to clipboard contains wrong measure file 

  

https://etas-tfs.de.bosch.com/tfs/web/wi.aspx?pcguid=a19b416c-a152-41b1-be99-52dd18194b4b&id=673863
https://etas-tfs.de.bosch.com/tfs/web/wi.aspx?pcguid=a19b416c-a152-41b1-be99-52dd18194b4b&id=674620
https://etas-tfs.de.bosch.com/tfs/web/wi.aspx?pcguid=a19b416c-a152-41b1-be99-52dd18194b4b&id=674665
https://etas-tfs.de.bosch.com/tfs/web/wi.aspx?pcguid=a19b416c-a152-41b1-be99-52dd18194b4b&id=676741
https://etas-tfs.de.bosch.com/tfs/web/wi.aspx?pcguid=a19b416c-a152-41b1-be99-52dd18194b4b&id=678471
https://etas-tfs.de.bosch.com/tfs/web/wi.aspx?pcguid=a19b416c-a152-41b1-be99-52dd18194b4b&id=678570
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3.4. Known Issue Reports 

If a product issue develops, ETAS will prepare a Known Issue Report (KIR) and post it on the internet. 

The report includes information regarding the technical impact and status of the solution. Therefore 

you must check the KIR applicable to this ETAS product version and follow the relevant instructions 

prior to operation of the product. 

The Known Issue Report (KIR) can be found here: 

http://www.etas.com/kir  

3.5. Known Issues 

This section describes known problems of the released version of MDA V8.6.x. 

3.5.1. Software related Items 

General: 

- With older versions of Windows® 10 problems when waking up from sleep mode can happen. 
These Windows versions are not supported any longer by MDA (see section 2.2.1 ‘System 
Prerequisites’ on page 8). 

- If MDA reacts with an exception when connecting to, or disconnecting from an external monitor, 
optionally combined with sleep mode of the computer, an update of the driver for the graphical 
card is recommended. 

- After the first installation of an MDA V8.6.x version the format definitions for textual measure file 
formats (INI files) need to be copied from the folder C:\ProgramData\ETAS\MDA\8.5 into folder 
C:\ProgramData\ETAS\MDA\8.6.  

- In the category ‘Custom Filter(s)’ of the Variable Explorer a LAB file appears only if at least one of 
the entries in the LAB file matches to one of the signals of any source file.  

 

Data: 

- MDF standard indexing is beneficial for data display, missing index impairs performance. 

- MDA supports scalars only including Enumerations, String, Events.  
Arrays and Structs (e.g. maps/curves from calibration recording) are not supported. 

- Not supported conversion types are:  

o Signals with nested conversions, except STATUS_STRING_REFs  

o Free form  

o Text-to-Value 

- Export of EVENT signals from MDA user interface is not supported.  
MdfConvert.exe provides a specific argument to include Events.  

- For drawing the signal curve of a STATUS_STRING_REF signal in an oscilloscope the numeric 
conversion formula is used even when the sample has a verbal conversion.  
The textual value is shown in the cursor tooltip and cursor column of the signal list. When using 
the STATUS_STRING_REF signal as input for a calculated signal, samples with a textual value 
result in invalid samples of the calculated signal. 

- Time channel physical values must be in seconds. Due to nano-seconds precision time stamps > 
~1Mio seconds (~10 days) are not supported. 

- Time channel data type must be of Floating point 64 bit. 

- For files with a virtual master channel, file indexing is not used, thus performance might be 
lower. 

- Delay State function supports a positive delay only. In case of a negative delay value, no data is 
displayed. For a signal time offset use calculated signal’s ‘Output Options’.  

http://www.etas.services/kir
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- Individually shifted signals are ignored when determining the complete time range.  

- For MDF3 files the DISPLAY_IDENTIFIER contains the device name.  

- When exporting / converting files in DXL format into MDF V3 format, the process might be 
extremely slow, and does not react on ‘Cancel’.  

- If measure files are combined by means of MdfCombine.exe and the original files include 
references to video files, the combined measure file can not display the video channel. 

- MDF files for usage in MDA must have the time signal defined as the master channel, and time 
stamps must be increasing. 

 

Instruments & Layers (General): 

- Instrument drawing in MDA V8 is optimized for many layers with few instruments per layer. With 
many oscilloscopes on one layer bad loading and updating times can be observed. Then it is 
advisable to distribute the oscilloscopes onto separate layers. 

- Synchronization is limited to one mode and one synchronization group. 

- When storing a configuration having layers arranged side-by-side, the arrangement of the layers 
gets lost, and cannot be restored when opening the configuration again. 

- If the screen setting for size is higher than 100%, and signals are dragged and dropped onto the 
layer background, the window for selecting an instrument opens shifted from the dropping point. 
It might even be shifted outside the visible area. Instead dropping on the layer tab can be used. 

 

Oscilloscope & Scatter Plot: 

- In case of problems while creating an oscilloscope, please update your graphic device driver, if 
needed manually.  

- Oscilloscope: If a sample is flagged as ‘invalid’ no signal curve is drawn for this pixel column. This 
causes that also other samples falling on the same pixel column will not be visible. Especially on 
high zoom levels this can hide extreme values. In case you observe a gap in the signal curve: 
zoom-in until samples get drawn individually, or use a table instrument to check the proximity of 
the invalid sample.  

- Value axis representation in oscilloscope and scatter plot switches automatically to a scientific 
representation if the range is larger than 10,000,000 or smaller than 0.001. This cannot be 
configured. Alternatively, a calculated signal can be created for which the value is divided or 
multiplied with a multiple of 10, so that the result is again in a range for which usual (non-
scientific) values will be shown. 

- Limitations of Scatter Plot instrument: 

o Cursor synchronization is not supported. 

o Per strip only one signal can be assigned to the y axis. 

o Samples are drawn based on time relation of signals on x and y axes, therefore signals should 

be from the same measure file and preferably acquired in the identical measure raster.  

 

Event List: 

- Event List Instrument: when using cascaded calculated signals the calculation might take long 
time till data is displayed in the instrument.  

 

GPS Map: 

- To enable a download of maps for the GPS map instrument, Port 443 (over https) and URL: 
maps.omniscale.net must be unblocked in the firewall / network settings. 

- GPS Map instrument has a time-out of 5 seconds. If the longitude and latitude values are not 
available within this time range, the track is handled as invalid. This might happen for example if 
the measure file is a textual file format with many samples for the signals, or if the file is stored 
on a network share. 
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Import and Calculated Signals: 

- From XDA files only yt-oscilloscopes, xy-oscilloscopes and tables are imported. A message in the 
status bar resp. the Notifications window lists not imported instruments. 

- Import of calculated signals from *.xda or *.xcs files fails if the configuration contains already a 
calculated signal with the same name. A message in the status bar informs about not imported 
calculated signals. Rename the existing calculated signal and retry the import. 

- Calculation results might differ slightly from those in INCA or MDA V7, especially if the calculation 
requires an initial value. For details see the Appendix of the User Manual. 

- When for a calculated signal the formula is imported, and the calculated signal was recorded into 
a measure file, MDA V8 displays the result of the re-calculation in MDA. The recorded calculated 
signal can be selected independently from the measure file. 

- With V8.5.1 the behavior of calculated signals was changed. Now the result of the calculation 
additionally depends on whether the input signal has ‘No Value’ or is in ‘Invalid’ state. A detailed 
overview is given in the Appendix of the User Manual. 

o Valid samples with value result usually in valid samples with value 

o Valid samples without value (‘No Value’) are treated as if they are not present at all, i.e., the 

result of the calculation is also a valid sample but without value 

o ‘Invalid’ samples (with and without value) represent errors and will be processed, possibly also 

causing the state of the resulting calculation to go into invalid state 

- When layers, instruments and signals are copied via Configuration Manager, also calculated 
signals are copied and pasted, but only the assignment of the calculated signals to instruments, 
and not the definition of calculated signals. 
Alternatively an Import of the instruments and the calculated signals can be done. 

- When a calculated signal is imported from an *.xdx configuration file, or if it is copied from the 
Calculated Signals docking window and pasted into another configuration, MDA checks whether 
source and target have a reference to one measure file only.  
If so the reference to the original measure file is mapped to the one available measure file in the 
target configuration. In case there are multiple files defined in the source or available in the 
target the reference of the input signal(s) remains unchanged, i.e. the imported or the pasted 
calculated signals cannot be used without a manual adaptation of the input signal’s reference.   
Additionally, when the imported or pasted calculated signal has a reference to another calculated 
signal, the calculated signal with the same name is used as input signal automatically. This might 
be incorrect, if calculated signals were renamed. 

- For calculated signals imported from INCA with a data type defined as UINT32 the imported 
formula must be adapted. The imported formula needs to be combined using a logical AND with 
a bitmask: “(Imported Formula) & 0xffffffff”.  
Then the result in MDA V8 corresponds to a UINT32 data type. 

- With MDA V8.6.0 a change in the internal handling of variables from a CDF files was done. This 
can cause that in configurations loaded for the first time in MDA V8.6 maps and curves used in 
calculated signals as look-up tables are not mapped automatically.  
A manual remapping solves the problem and the calculated signal can be used again. 

- With MDA V8.6.4 a special handling was introduced for samples which are flagged as invalid and 
appear at the very beginning of a measure file. These samples are ignored, i.e. handled as not 
available. The invalid flag is supported only in MDF V4.x format, but not in MDF V3. Invalid flags 
cause that a calculation result is also flagged as invalid. By handling such initial invalid samples 
as not available, the result of a calculation with history (e.g. an average, or integral) can be 
different between MDF V3.x and MDF V4.x files. 

 

Functional Mockup Units (FMUs) 

- FMUs must be according to FMI standard V2. 

- ASCMO V5.8 or higher is required to create FMUs from ASCMO models for the usage in MDA V8. 

- Possibly FMUs created with other applications than ASCMO might fail when being used in MDA 
V8, especially if these require from the user to define a parameter value. In case you face 
problems with your FMU files, please inform the ETAS support team. 
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- FMUs must be stored under 
C:\ProgramData\ETAS\MDA\8.6\CorePlugins\Etas.TargetAccess.VirtualTarget 

This can be done easily via of the “+” icon in the Function Library area of MDA V8.6.5 or higher. 

- Only FMUs can be used which contain a ‘DefaultExperiment’ block.  
Optionally such a block can be inserted manually in the XML file: 

<DefaultExperiment 

  startTime="0.0" 

  stopTime="100" 

  stepSize="1"/> 

Afterwards the adapted XML file must be stored again in the zipped FMU file. 

The “stepSize” parameter is often crucial for a proper calculation. The value “1” listed above is 
just an example. Its value must be set according to the needs of the FMU.  
Values of StartTime and StopTime are just placeholders, the calculation is adapted to the actual 
time range of the measure file and the measure data. 

- Input signals for functions must be numeric. If an enumeration signal shall be used, first create a 
calculated signal: Calculated Signal = Raw (Enumeration Signal). This converts the input signal to 
its decimal value. Then the calculated signal can be used as input for the function. 

- There are sometimes problems when displaying enumeration signals and the output signals of 
FMUs in the same oscilloscope or table instrument. Then assign the signals to different 
instruments. Please inform the ETAS Support team in case you observe such problems. 

- When applying a time offset to an output of a Function, MDA creates automatically a calculated 
signal and applies the time shift to the Calculated Signal.   

 

User Interface & Operation: 

- For some areas keyboard operation is not supported so far, e.g. Variable Explorer, or Video 
instrument. A complete list of all supported hotkeys is given via CTRL+F1. 

- To benefit from the latest improvements in MDA – EHANDBOOK-NAVIGATOR coupling, usage of 
EHB-NAVIGATOR V11.1 is recommended. 

- Snapshot Recording requires MDA V8.4.1 (or higher) in combination with INCA V7.3.0 (or higher) 
and MDF V4.x format. 

- For some UI elements it might happen that terms are given in English language only. Translation 
is in progress and enhanced with every new MDA V8 version. 

 

4. Contact, Support and Problem Reporting 

For details of your local sales office as well as your local technical support team and product hotlines, 

take a look at the ETAS website: 

ETAS subsidiaries www.etas.com/en/contact.php  

ETAS technical support www.etas.com/en/hotlines.php  

 

http://www.etas.services/en/contact.php
http://www.etas.services/en/hotlines.php

